Chapter 7
Working with Styles
This document is Copyright © 2010-2014 by the LibreOffice Documentation Team. Contributors are listed below. You may distribute it and/or modify it under the terms of either the GNU General Public License (http://www.gnu.org/licenses/gpl.html), version 3 or later, or the Creative Commons Attribution License (http://creativecommons.org/licenses/by/4.0/), version 4.0 or later.

All trademarks within this guide belong to their legitimate owners.

Contributors

John A Smith  Ron Faile Jr.
Jean Hollis Weber  Leo Moons

Feedback

Please direct any comments or suggestions about this document to the Documentation Team’s mailing list: documentation@global.libreoffice.org

Note: Everything you send to a mailing list, including your email address and any other personal information that is written in the message, is publicly archived and cannot be deleted.

Acknowledgments

This chapter is adapted and updated from Chapter 7 of the OpenOffice.org 3.3 Writer Guide. The contributors to that chapter are:

Agnes Belzunce  Bruce Byfield  Daniel Carrera
Peter Hillier-Brook  Peter Kupfer  Ian Laurenson
Iain Roberts  Gary Schnabl  Barbara M. Tobias
Jean Hollis Weber  Sharon Whiston  Michele Zarri

Publication date and software version

Published 25 May 2014. Based on LibreOffice 4.2.

Note for Mac users

Some keystrokes and menu items are different on a Mac from those used in Windows and Linux. The table below gives some common substitutions for the instructions in this chapter. For a more detailed list, see the application Help.

<table>
<thead>
<tr>
<th>Windows or Linux</th>
<th>Mac equivalent</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Options menu selection</td>
<td>LibreOffice &gt; Preferences</td>
<td>Access setup options</td>
</tr>
<tr>
<td>Right-click</td>
<td>Control+click and/or right-click depending on computer setup</td>
<td>Opens a context menu</td>
</tr>
<tr>
<td>Ctrl (Control)</td>
<td>% (Command)</td>
<td>Used with other keys</td>
</tr>
<tr>
<td>F5</td>
<td>Shift+%F5</td>
<td>Open the Navigator</td>
</tr>
<tr>
<td>F11</td>
<td>%+T</td>
<td>Open Styles &amp; Formatting window</td>
</tr>
</tbody>
</table>

Documentation for LibreOffice is available at http://www.libreoffice.org/get-help/documentation
Contents

Copyright.................................................................................................................................2
  Contributors.........................................................................................................................2
  Feedback...............................................................................................................................2
  Acknowledgments................................................................................................................2
  Publication date and software version................................................................................2

Note for Mac users..................................................................................................................2

Introduction............................................................................................................................5

Creating custom (new) styles...............................................................................................5
  The Style dialog.....................................................................................................................5
  The Organizer page...............................................................................................................5
  Understanding linked styles.................................................................................................6
    Creating a linked style.........................................................................................................7
    Example: Changing a property of a parent style...............................................................7

Working with paragraph styles............................................................................................8
  Settings on the Indents & Spacing page................................................................................8
  Settings on the Alignment page.............................................................................................8
  Text flow options for paragraph styles................................................................................10
  Font options for the paragraph style....................................................................................12
    Specifying a relative font size............................................................................................12
    Selecting a language for a paragraph style........................................................................13
  Options for positioning text.................................................................................................13
    Example: Rotating the text in a paragraph style...............................................................14
    Spacing options...............................................................................................................14
  Controlling tab stops...........................................................................................................15
  Using the Outline & Numbering page...................................................................................16
  Setting up a drop cap...........................................................................................................16
  Setting up paragraph background and borders....................................................................17

Working with conditional paragraph styles.......................................................................17

Working with character styles..............................................................................................19
  Why use character styles?......................................................................................................19
  Creating a new character style.............................................................................................19
  Migrating to character styles...............................................................................................19

Working with frame styles....................................................................................................21
  How frame styles work..........................................................................................................21
  Planning the styles.................................................................................................................21
  Creating new frame styles.....................................................................................................22

Working with page styles.......................................................................................................23
  Creating a new page style......................................................................................................23
  The Organizer page...............................................................................................................23
    The next style property.......................................................................................................23
    Setting up a title page.........................................................................................................23
  General settings for the page style.......................................................................................24
Working with list styles..................................................................................................................30

Defining the appearance of a nested list..........................................................................................30

Creating a new list style..................................................................................................................31

- Bullets, Numbering Styles, and Image pages.................................................................................31

- Outline page....................................................................................................................................31

- Position page..................................................................................................................................31

- Options page..................................................................................................................................33

Combining list and paragraph styles.................................................................................................34

Example: Creating a simple list style..................................................................................................35

- Creating the CDTracks numbered list..............................................................................................35

- Applying the list style......................................................................................................................36
Introduction

Chapter 6, Introduction to Styles, describes the basics of how to use, apply, and manage styles. This chapter gives a more detailed description of how to create or modify a style, using the many options available on the various pages of the Style dialog. You will learn how these options affect the appearance of the style and how to use them efficiently. Examples and hints are also provided.

The Style dialogs share many of the same pages as the manual formatting dialogs, so you can also use this chapter to help you apply manual formatting (though you do not need that if you use styles).

Creating custom (new) styles

In addition to using the predefined styles provided by LibreOffice, you can add new custom (user-defined) styles. In Chapter 6, two methods are given for creating a new style: the drag-and-drop approach and the New Style from Selection icon in the Styles and Formatting window.

These methods are very convenient because it is possible to immediately check the visual effects that the style produces before creating it. However, they may require you to access several different menus, and you have a somewhat reduced amount of control on style (particularly when it comes to organizing them). The method described in this chapter, therefore, concerns only the use of the Style dialog.

The Style dialog

Open the Styles and Formatting window. Select the category of style you want to create by clicking on the appropriate button in the top part of the Styles and Formatting window. For example, select the third button from the left if you want to create a new frame style.

Right-click in the window and select New from the context menu. Except for the Page and List styles, the style dialog which opens will be linked to one of the existing styles. You can choose a different style from the Linked with drop-down list, or choose None.

The dialog that is displayed depends on the type of style you selected. Many of the pages are the same as those that are displayed when manual formatting is applied. Therefore, if you are familiar with manual formatting, you will find that you already know how to use most of the options.

Tip

The dialogs used to create a new style and to modify an existing style are mostly the same, but with one exception: conditional styles have a different dialog. See “Working with conditional paragraph styles” on page 17.

The Organizer page

When creating a new style, the first page you need to set up is the Organizer, which is shown in Figure 1. This page is common to all style categories, with only small differences between them. Therefore, it is described only once.

Depending on the style you are creating, you will find the following information on this page:

- **Name**: present on all the categories. Use this field to give a name to the style you are creating.
- **AutoUpdate**: only present for paragraph and frame styles. If it is checked, then Writer will apply any modification made manually to a paragraph formatted with that style to the style itself.
Caution

If you are in the habit of manually overriding styles in your document, be sure that AutoUpdate is not enabled, or you will suddenly find whole sections of your document reformatted unexpectedly.

![Paragraph Style dialog box](image)

**Figure 1:** The Organizer page displayed when a new Paragraph style is created.

- **Next Style:** only available for paragraph and page styles. Use it to specify which style will be applied to the next element. It is customary, for example, to have a left page style followed by a right page, a first page followed by a left page, a heading followed by body text, and so on. You will see in the example later how this property is used. Predefined paragraph styles for lists or bullets also make large use of the Next Style property.

- **Linked with:** available for paragraph, character, and frame styles; it determines the position of the style in the hierarchy. When creating a new style and linking it to an existing style, all the starting properties of the style are copied from the linked style.

- **Category:** available for all styles; use it to associate the new style with one of the categories. Note that you cannot change the category of the predefined styles. Setting this field is useful when filtering the contents of the Styles and Formatting window.

- **Contains:** shows a summary of the properties of the style.

### Understanding linked styles

When creating a new paragraph or a new character style, you may use an existing style as a starting point for its settings. In this sense, LibreOffice links the styles together.

When styles are linked, a change in the parent style affects every style linked to it. You can easily visualize the connections between styles by switching to the Hierarchical view in the Styles and Formatting window filter. For example, every Heading style (such as Heading 1, Heading 2) is linked with a style called Heading. This relationship is illustrated in Figure 2.

![Hierarchical view of linked styles](image)

**Figure 2:** Hierarchical view of linked styles.

Linking styles is a very powerful method to create “families” of styles and allows you to change their properties simultaneously. For example, if you decide that all the headings should be green (such as in this guide), you only need to change the font color of the parent style to achieve the desired result. Note however, that changes made to a parameter of the parent style do not override changes previously made to the same parameter in the child styles. For example, if you changed
the *Heading 2* font color to green, a change of the font color of the *Heading* style (the parent style) to red will not affect the *Heading 2* font color.

You can easily check which properties are specific to a style by looking at the *Contains* section of the *Organizer* page. In case you want to reset the properties of a child style to that of the parent style, click the **Standard** button located at the bottom of each Paragraph and Character style dialog page.

---

**Note**

You cannot define a hierarchical style structure for Page, Frame and List styles.

---

**Creating a linked style**

To create a linked style, you can either specify the parent style (the “linked with” style) in the *Organizer* page of the Style dialog, or you can start creating a new style by right-clicking in the Styles and Formatting window on the style to be linked with and selecting **New** from the drop-down menu.

**Example: Changing a property of a parent style**

Suppose that you want to change the font of not only *Heading 1* or *Heading 2*, but all headings. The easiest way to do that is to take advantage of *linking*.

Open the Styles and Formatting window (press F11), select the Paragraph Styles category, right-click on *Heading*, then select **Modify** to open the Paragraph Style dialog for the *Heading* style.

Select the **Font** tab, then select a font and click **OK**.

![Figure 3: Select Heading style.](image)

Now, the fonts of all the heading styles (*Heading 1* through *Heading 10*) are changed in a single operation. Figure 5 shows on the left a document using the headings 1, 2 and 3 and on the right the same document after changes have been made to the *Heading* style.

---

Creating custom (new) styles
Working with paragraph styles

Although this section describes most of the parameters scattered over the twelve tabbed pages shown in Figure 4, you do not need to configure them all. In fact, in the vast majority of cases, it is sufficient to modify only a few attributes, particularly if you make use of the linking properties of styles or when basing the new style on one which is already similar.

Settings on the Indents & Spacing page

On the Indents & Spacing page, you can set up the parameters that affect the position of the paragraph on the page and the spacing between lines and between this paragraph and the paragraphs nearby. The right hand side of the page shows a preview of the applied settings.

Use the Indent section of the page to set up the indentation, using these parameters:

- **Before text**: controls the space in the selected unit of measurement between the left margin of the page and the leftmost part of the paragraph area. Entering a negative value results in the text starting on the left of the margin. This may be useful in situations where your left margin is quite wide, but you want the headings to be centered in the page.
- **After text**: controls the space in the selected unit of measurement between the right margin of the page and the rightmost part of the paragraph area. Entering a negative value results in the text extending into the right margin of the page.
- **First line**: enter the offset in this box (either positive or negative) of the first line of the paragraph relative to the paragraph area. A positive value increases the indentation of the first line, while a negative value makes the first line start to the left of the paragraph area.
- **Automatic**: check this box to allow Writer to automatically control the indentation of the first line. The value is calculated by Writer on the basis of the font size and other parameters.

Use the Spacing section of the page to determine the amount of vertical space above and below the paragraph. It is customary to include some “space above” in heading styles so that they are separated from the text body of the previous section without the need to insert empty paragraphs. Spacing between paragraphs is also normal in certain types of documents. The body text style of this guide is configured to leave some space between consecutive paragraphs.
The option to remove space between paragraphs of the same style is available by selecting the check box.

The spacing between paragraphs does not affect the spacing between lines, which is controlled using the drop-down box in the *Line spacing* section. You can select one of the following values:

- **Single**: the default setting—applies a single line spacing to the paragraph. This is calculated automatically based on the font size.
- **1.5 lines**: sets the line spacing to 1.5 lines.
- **Double**: sets the line spacing to 2 lines.
- **Proportional**: this value activates the edit box next to the drop-down list where you can enter a percentage value. 100% means a single line spacing, 200% double line spacing and so on.
- **At least**: this choice activates the edit box next to the drop-down list, where you can enter the minimum value (in your selected unit of measurement) to be used for the line spacing.
- **Leading**: if this is selected, you can control the height of the vertical space between the base lines of two successive lines of text, by entering a value, which is summed with the value of single line spacing, into the edit box.
- **Fixed**: this choice activates the edit box next to the drop-down list, where you can enter the exact value of the line spacing.

**Tip**

When using different font sizes in the same paragraph, the line spacing will be uneven, as Writer automatically calculates the optimal value. To obtain evenly spaced lines, select *Fixed* or *At least* in the drop-down list and a value that is large enough to create a spacing between the lines sufficient to account for the largest font size used.
The last parameter that can be set in this page is Register-true. This is a typography term that is used in printing. This term refers to the congruent imprint of the lines within a type area on the front and the back side of book pages, newspaper pages, and magazine pages. The register-true feature make these pages easier to read by preventing gray shadows from shining through between the lines of text. The register-true term also refers to lines in adjacent text columns that are of the same height.

When you define a paragraph, Paragraph Style, or Page Style as register-true, the base lines of the affected characters are aligned to a vertical page grid, regardless of font size or of the presence of graphics. This aligns the baseline of each line of text to a vertical document grid, so that each line is the same height.

To use this feature, you must first activate the Register-true option for the current page style. If you have activated the Register-true for the page style in use (refer to “General settings for the page style” on page 24) then the Reference style and all the styles hierarchically dependent on it will have the Activate Register-True box selected. You may also, however, want to activate the vertical grid for other styles (or not apply it to styles dependent on the reference style) and this is where this can be done.

**Settings on the Alignment page**

Use the Alignment page to modify the horizontal alignment of the text, choosing between **Left**, **Right**, **Center**, and **Justified**. The results of the selection are shown in a preview window on the right-hand side of the page.

When selecting the **Justified** alignment, you can also decide how Writer should treat the last line of the paragraph. By default, Writer aligns the last line to the left, but you can choose to align it to the center or to justify it (meaning that the words on the last line will be spaced in order to occupy it fully). If you have selected to justify the last line and select the **Expand single word** option, then whenever the last line of a justified paragraph consists of a single word, this word is stretched by inserting spaces between characters so that it occupies the full length of the line.

The alignment page is also used to control the **Text to Text** vertical alignment—useful when you have mixed font sizes on the same row. Choose the element of the fonts on the line that will be aligned between **Automatic**, **Baseline**, **Top**, **Middle**, **Bottom**. Refer to Figure 7 for a visual representation of these reference points.

![Text Alignment Examples](image)

*Figure 7: Text to text vertical alignment: Baseline, Top, Middle, Bottom*

**Text flow options for paragraph styles**

The page of the dialog controlling the text flow options is shown in Figure 8. This page is divided into three parts: **Hyphenation**, **Breaks**, and **Options**.
With *Hyphenation* selected, three parameters are settable:

- **Characters at line end**: controls the minimum number of characters to be left on a line before inserting a hyphen.
- **Characters at line begin**: controls the minimum number of characters that can be placed at the beginning of a new line following a hyphen.
- **Maximum number of consecutive hyphens**: controls the number of consecutive lines that terminate with a hyphen.

If you prefer Writer to automatically control the hyphenation, select the **Automatically** option.

![Hyphenation options](image)

**Figure 8: The options on the Text Flow page of the Paragraph dialog**

In the **Breaks** section, you can require a paragraph to start on a new page or column, as well as specify the position of the break, the style of the new page, and the new page number. A typical use for this option is to ensure that the first page of a new chapter always starts on a new (usually right-hand) page.

To always start a style on a new page, choose the following settings on the **Text Flow** page of the Paragraph Style dialog:

1. In the **Breaks** section, select **Insert**. Make sure that **Type** is set to **Page** and **Position** is set to **Before**.
2. Select **With Page Style** and choose the page style from the list.
3. To continue page numbering from the previous chapter, leave **Page number** set at 0. To restart each chapter’s page numbering at 1, set **Page number** to 1. Click **OK**.

**Note**

If you want the first page of a new chapter to always start on a right (recto) page, make sure that the page style for the first chapter page is set for the **right page only** by making this selection in the **Layout settings** field on the **Page** tab of the Page Style dialog.
The Options section of the Text Flow page provides settings to control what happens when a paragraph does not fit on the bottom of a page:

- **Do not split paragraph** means that the paragraph is never split across two pages. If it does not fit on the bottom of one page, the entire paragraph moves to the top of the next page.
- **Keep with next paragraph** is appropriate for headings or the lead-in sentence to a list, to ensure that it is not the last paragraph on a page.
- **Orphan control** and **Widow control**. Widows and orphans are typographic terms. An orphan is the first line of a paragraph alone at the bottom of a page or column. A widow is the last line of a paragraph that appears alone at the top of the next page or column. Use these options to allow paragraphs to split across pages or columns but require at least two or more lines to remain together at the bottom or top of a page or column. You can specify how many lines must remain together.

**Font options for the paragraph style**

Three pages of the Paragraph Style dialog are dedicated to settings controlling the appearance of the font, namely, the **Font**, **Font Effects**, and **Position** pages. The use of the first two pages is straightforward. Many of the options used when creating a character style are discussed in “Creating a new character style” on page 20. Options that can be used when creating a paragraph style are described here.

**Specifying a relative font size**

If you are creating a style based on another style (linked style), you can specify a font size relative to that other style—either as a percentage or as a plus or minus point value (–2pt or +5pt). Relative font sizes are commonly used for Web pages.

For example, the paragraph style **Heading 1** is based on the paragraph style **Heading**. The font size of the paragraph style **Heading** is 14pt, and the font size of paragraph style **Heading 1** is specified as 130%. Thus, the resultant font size of text in a paragraph formatted with the **Heading 1** paragraph style is 14pt times 130% = 18.2pt.

To specify a percentage font size: in the Paragraph Style dialog, select the **Font** tab. In the **Size** box, enter the percentage amount followed by the symbol % (see Figure 9). Similarly, you can enter a plus or minus sign followed by the number of points to be added or subtracted from the base font size.

![Figure 9: Selecting a type size based on a percentage](image-url)
To change from a relative font size back to an absolute font size, enter the desired font size in points followed by the letters pt.

It is also possible to use a Percentage Font size for character styles.

**Selecting a language for a paragraph style**

The language you select for a document (on Tools > Options > Language Settings > Languages) determines the dictionary used for spell checking, thesaurus, hyphenation, the decimal and thousands delimiter used, and the default currency format.

Within the document, you can apply a separate language to any paragraph style. This setting has priority over the language of the whole document. On the Font page of the Paragraph Style dialog, languages with installed dictionaries are marked in the Language list by a small ABC icon (Figure 10). When checking spelling, Writer will use the correct dictionary for paragraphs with this style. If you write documents in multiple languages, you can use the linked styles to create two paragraph styles that differ only in the language option. If you then want to change some of the other properties of the paragraph style, all you need do is to change the parent style.

To insert occasional words in a different language and avoid their being picked by mistake with the check-spelling function, it is more convenient to use a character style, as discussed in “Creating a new character style” on page 20.

**Options for positioning text**

The Position page of the Paragraph Style dialog collects all the options that affect the position of the text on the screen or printed page. This page is divided into three sections, plus a preview area. They are: Position, Rotation/Scaling, and Spacing.

---

**Working with paragraph styles**

13
Use the Position section to control the appearance of superscripts and subscripts. However, you will normally apply superscript and subscripts to groups of characters rather than to entire paragraphs. Therefore, it is strongly recommended to change these parameters only when defining a character style and, instead, leave the default settings for the paragraph styles.

The second section of the Position page controls the rotation of the paragraph area. Two common uses for rotated paragraphs are:

- To put portrait headers and footers on a landscape page
- To fit headings above narrow table columns (as shown in Figure 12)

![Figure 12: A table with rotated headings](image)

The Scale width box controls the percentage of the font width by which to compress or stretch the rotated text horizontally. That is, from the first character to the last.

Chapter 4, Formatting Pages, describes how to create portrait headers and footers on landscape pages by rotating characters. You can achieve the same effect by defining a separate header or footer paragraph style specifically for landscape pages.

**Example: Rotating the text in a paragraph style**

As an example, we will apply rotated table headings to a pre-existing table.

1) Create a new paragraph style. Name it **Table Heading Rotated**.
2) On the Position page of the Paragraph Style dialog, in the Rotation / scaling section, select 90 degrees. Click **OK** to save the new style.

![Figure 13: Rotating a paragraph 90 degrees](image)

3) Select the heading row of the table and apply the new style. Any text in the cells of the heading row is now rotated.
4) If the headings are aligned to the top of the cells, you may want to change the alignment to the bottom of the cells, as shown in Figure 12. To do this, click the **Bottom** button on the Table toolbar or select **Format > Alignment > Bottom** from the main menu.
**Spacing options**

Use the *Spacing* section of the Position page to control the spacing between individual characters in the paragraph. When selecting an option other than default in the drop-down menu, use the edit box to enter the value in points by which you want to expand or condense the text.

The **Pair Kerning** option (selected by default) increases or decreases the amount of space between certain pairs of letters to improve the overall appearance of the text. Kerning automatically adjusts the character spacing for specific letter combinations. Kerning is only available for certain font types and, for printed documents, only works if your printer supports it.

![Figure 14: Kerning disabled (left) and enabled (right).](image)

**Controlling tab stops**

Although borderless tables are generally considered a much better solution to space out material across a page, in many situations tabs are sufficient to do what you need, with the added advantages of being simpler to manage and quicker to apply.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you need to use tabs, and you will be sending a document to other people, <em>do not</em> use the default tab stops. If the recipients of the document have defined default tab stops that are different from the ones you are using, the paragraph may look very different on their machines. Instead, define the tab stops explicitly in the paragraph or the paragraph style; then you can be sure that everyone will see the same layout.</td>
</tr>
</tbody>
</table>

To define tab stops in your paragraph style, use the Tabs page, shown in Figure 15. Here you can choose the type of tab: left, right, centered, or decimal; the character to be used as a decimal point; and the fill character—the characters that appear between the end of the text before the tab and the beginning of the text after the tab. You can also create a custom fill character by entering it in the corresponding box. Common use of a fill character is adding dots between a heading and a page number in a table of contents or underscore character when creating a form to fill in.

![Figure 15: Specifying tab stops for a paragraph style](image)

Creating a new tab stop, therefore, is just a matter of deciding its position relative to the left margin, the type, the fill character and clicking the **New** button. The tab stop will be entered in the *Position* list on the left hand side. Unfortunately, the only way to modify the position of a tab stop is to create a new one in the desired position and delete the old one using the buttons on the right-hand side of the page.

Note that it is not possible to define tabs that exceed the page margin. In the rare cases where that may be needed, use a borderless table instead.
Using the Outline & Numbering page

Use the Outline & Numbering page if you want to number the paragraph, if for example this style is to be used for a heading or list item.

You can assign an outline level to any paragraph style. This feature enables you to create a table of contents that includes those headings along with the headings using styles listed in Tools > Outline Numbering. For example, you might use a different sequence of styles for annexes (appendixes), but you want the annex headings and subheadings to appear in the TOC at the same levels as the chapter headings and subheadings.

To assign an outline level to a paragraph style, go to the Outline & Numbering page for the style, and select the required outline level. Click OK to save this change.

This page should be used in combination with list styles when you need to associate a certain paragraph style with a list style. Refer to “Combining list and paragraph styles” on page 34 for additional information on how to use this page, as well as an example.

Setting up a drop cap

If you want your paragraph to use drop caps (usually this is suitable for a first paragraph style), then you can predefine the properties in the Drop Caps page of the paragraph style dialog. Selecting the option to display drop caps enables the subsequent options where you can fine tune the appearance: the number of lines occupied, the number of characters to enlarge (if you want the whole first word, check the corresponding box), and the space between the drop caps and the text.

Drop caps use the same font and have the same properties as the rest of the paragraph; however, you can easily modify their appearance by creating a specific character style and using it. For
example, you may want the drop caps to be of a different color or apply an outline effect. Select the character style you want to use in the corresponding drop-down menu.

**Setting up paragraph background and borders**

Adding a background color and a border to a paragraph is a good way to make it stand out without having to insert a frame. You can customize the background and border of the paragraph areas using the corresponding pages of the Paragraph Style dialog. In addition to highlighting, borders are also often used to separate header and footer areas from the main text area (such as in this guide) as well as to provide decorative elements in some heading styles.

The two pages are fairly intuitive. You may want to pay attention to the following points when working with the **Background** page:

- In case you do not find the desired color in the list of predefined ones, you can define your own by selecting **Tools > Options > LibreOffice > Colors**.
- You can use a graphic instead of a solid color as background. In the **As** drop-down list, select **Graphic**, then select the graphic object you want to use and adjust the parameters, as required. Detailed instructions on working with graphic backgrounds can be found in the Impress Guide.
- Different backgrounds can be selected for the paragraph area and for the characters in the paragraph. Select **Paragraph** in the **For** box for the paragraph background, and **Character** for the background of the text. View your choices in action by clicking **Apply**. To accept your choices click **OK**. Click **Standard** to return all the settings to defaults for a modified style.
- The background is only applied to the paragraph area. If you have defined an indented paragraph, the space between the paragraph and the margin does not have the paragraph’s background color.

![Figure 18: Different Paragraph and Character backgrounds set](image)

**Working with conditional paragraph styles**

A conditional paragraph style is another way of formatting text differently in different parts of a document. In some cases, you may find it saves time to use conditional styles rather than switching between styles as you type.

Making a paragraph style conditional means it changes its formatting depending on where it is used. For example, you may want the style **MyTextBody** to be black by default but turn white when inside a frame with a blue background.
Probably the most common use for conditional formatting is with single-style outlining. Single-style outlining is a type of outline numbering designed with a *Numbering* style, rather than with **Tools > Outline Numbering**. Instead of using different styles, it changes the number formatting whenever you press the Tab key to create a subordinate heading.

The only trouble with single-style outlining is that all levels look the same. This is where a conditional paragraph style comes in handy. Assign the paragraph style to an outline numbering style in the **Outline & Numbering** page and then open the **Condition** page. There, you can assign the levels of the outline numbering style to other paragraph styles. Then, when you press the Tab key while using the paragraph style, each level of the outline takes on different formatting, making single-style outlining even more convenient than it is on its own.

**Note**

Predefined styles (other than *Text body*) such as *Default*, *Heading 1*, and *Heading 2* cannot be set to be conditional.

**Caution**

If you want to make a style conditional, you have to do it while the style window is still open for the first time. After the window closes, the **Condition** tab no longer appears in the window.

---

When you create a conditional style, you are saying “in this condition make this style look like that other style.” For example, “When typing into a footer, make this style look like the *my_footer* paragraph style; when typing into a table, make this style look like the *table_text* paragraph style”.

In addition to setting the normal (unconditional) properties of the style, you need to define which other style it will look like in different situations. You do this on the **Condition** page.

To set up a conditional paragraph style:

1) Define a new paragraph style.
2) Select all the paragraph properties for the style. **Do not click OK!**
3) Click the **Condition** tab.
4) Select the **Conditional Style** option.
5) Select the first condition in the Context list (left side of the dialog) and select the style you want for this condition in the Paragraph Styles list on the right-hand side.

6) Click Apply. The name of the paragraph style appears in the middle list.

7) Repeat steps 5 and 6 for each condition you want to have linked to a different style.

8) Click OK.

When the style is selected, you will see that the formatting of your text depends on the context.

**Working with character styles**

Character styles complement paragraph styles and are applied to groups of characters, rather than whole paragraphs. They are mainly used when you want to change the appearance or attributes of parts of a paragraph without affecting other parts. Examples of effects that can be obtained by means of character styles are **bold** or **italic** typeface or colored words.

Two of the character styles used in this document are:

- Keystroke uses a custom *KeyStroke* style. For example:
  
  “To set Writer to full screen, press *Control*+*Shift*+*J*”.

- Menu paths use a custom *MenuPath* style. For example:
  
  “To turn field shadings on or off, choose View > Field Shadings”.

Other ways of using character styles are described elsewhere in the *Writer Guide*. These uses include making chapter numbers, page numbers, or list numbers larger than the surrounding text and formatting hyperlinks. When inserting words in different language or words you do not want the spell checker to detect as mistakes (for example procedure names in some programming language), character styles are quite useful because you can define the language to be applied in the character-style properties.

**Why use character styles?**

New Writer users often wonder, “*Why use character styles?*” or “*How is this different from clicking the bold icon to change the font typeface?*” The following real-life event illustrates the difference.

Jean is a technical writer from Australia. She learned the value of character styles after her publisher told her to unbold menu paths in her 200-page book. Jean had *not* used character styles. She had to edit all 200 pages by hand, with some help from Find & Replace. This was the last time Jean failed to use character styles.

Character styles do not have as many options as paragraph styles or page styles. Their benefits are of a different nature.

- **Formatting changes**
  
  As Jean's story illustrates, the ability to make formatting changes throughout a document can be important. Character styles provide this.

- **Consistency**
  
  Character styles help ensure that typesetting guidelines are applied consistently.

- **Focus on content**
  
  “*Was I supposed to bold keystrokes? How about menus?*”
  
  A writer should not have to remember the answers to these questions. Typesetting details distract you from the real content of your work. A properly named custom character style (such as *KeyStroke* or *MenuPath*) will remove this burden from you.
Creating a new character style

This section illustrates the use of the Character Styles dialog for creating a new character style.

The pages used to configure the character style have already been seen in the previous section on paragraph styles. Therefore, once you are familiar with creating paragraph styles, it will only take a few minutes to create a character style.

- Use the Organizer to set up the hierarchical level of the new character style (if needed) and to give it a name.
- Use the Font page to determine the font, style, and size for your character style. As with paragraph styles, you can specify the size as a percentage rather than providing the absolute value. For example, 150% means that when the character style is applied to a 10pt font size, the new font size will be 15pt, while if applied to a 14pt font size, the new size will be 21pt. You can also specify the Language of the text to which a certain character style is applied, so you can insert words in a different language and have them spell checked using the correct dictionary.
- In the Font Effects page, you can set up attributes such as font color, underlining, relief, or other effects. If you frequently use hidden text, for example, it is very convenient to define a character style where the Hidden option is marked. This way you only need a few mouse clicks to hide text. Relief effects may be appropriate for a drop cap or to give more emphasis to the chapter number or other parts of the title (as it is the case of this guide).
- You can use the Position page to create a subscript in case you are not satisfied with the default one or even a sub-subscript which may be useful for certain scientific publications. In the same page, you can create rotated, condensed, or expanded text.

**Note**

When rotating a group of characters, you also need to specify whether the rotated text should fit in the line or if, instead, it is allowed to expand above and below the line. This property only becomes active for character styles.

- Use the Background page to apply a colored background to the text. Applying a background to a character style yields the same effect as using the Highlighting tool on the Standard Toolbar.
- Finish creating a character style by assigning a border and a shadow to the text, if so desired.

Migrating to character styles

For people accustomed to formatting text manually, character styles can take some getting used to. Here are some suggestions for making the transition easier:

- *Never* mix character styles and manual formatting. Manual formatting supersedes character styles. If you combine them, you may end up wasting hours in frustration trying to figure out why your character styles don't work.
- Right-clicking and choosing **Clear Direct Formatting** removes manual formatting but not character styles. To remove a character style, select the characters, then select the **Default** character style.
- Realize that clicking the **Bold** icon in the toolbar is not easier than double-clicking on a character style that is preset for bolding the font typeface.
- Leave the Styles and Formatting window open to make character styles easy to access.
Working with frame styles

Frames are often used as containers for text or graphics. To provide consistency in the appearance of frames used for similar purposes, it is a good idea to define styles for frames. For example, you might want photographs to be enclosed in a frame with a drop-shadowed border, line drawings in a frame with a plain border, marginal notes in a frame without a border but with a shaded background, and so on.

Writer provides several predefined frame styles, which you can modify as needed, and you can define new frame styles. The technique for defining and applying frame styles is similar to that for other styles.

**Tip**

There is considerable overlap between the uses of frames and of sections for some page layout purposes. You may find it useful to take a look at Chapter 4, Formatting Pages, for information about the use of frames and sections.

How frame styles work

When an object is added to Writer, it is automatically enclosed in a frame of a predetermined type. The frame sets how the object is placed on the page, as well as how it interacts with other elements in the document. You can edit the frame by modifying the frame style it uses or by using a manual override when a frame is added to the document.

Because frames and objects are used together, it is sometimes easy to forget they are separate elements. In some cases, such as charts, you can edit the frame and object separately, so the distinction is worth remembering.

Unlike other elements that use styles, frames can be defined only partly by their style because their use can vary so much. Several elements of frames, such as the anchor and protected elements, need to be defined manually for individual frames.

You can format a frame manually when you select **Insert > Frame**. The dialog that opens contains all the settings available when frame styles are set up, as well as some only available when the frame is inserted. As with other styles, the most efficient way to format frames is in the Styles and Formatting window.

Planning the styles

If you are using a mix of graphics, you may want to define two related styles, one with a border line for graphics with white backgrounds and one without a border for all other backgrounds. You also may want to design one or more frames for text only.

Otherwise, the default frame styles (listed in Table 1) cover most users’ needs. The only significant addition that many users might need is one or more styles for text frames.

<p>| <strong>Table 1: Various frame styles and their uses</strong> |</p>
<table>
<thead>
<tr>
<th><strong>Style</strong></th>
<th><strong>Comments and Use</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Formula</td>
<td>The frame style used for formulas. The default includes <strong>AutoSize</strong>, which adjusts the size of the frame to the formula.</td>
</tr>
<tr>
<td>Frame</td>
<td>The default frame style.</td>
</tr>
<tr>
<td>Style</td>
<td>Comments and Use</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Graphics</td>
<td>The default style for graphics. The defaults include autosizing to fit the graphic, no text wrap, and a thin border around the frame. These are reasonable defaults, except for the border. Unless the background of the graphic is white and the document’s background also is white, the border usually is unnecessary.</td>
</tr>
<tr>
<td>Labels</td>
<td>The default style for use with File &gt; New &gt; Labels. It seems to be used by LibreOffice automatically and is not intended for users at all.</td>
</tr>
<tr>
<td>Marginalia</td>
<td>A style for placing a frame beside the left margin. As the name suggests, the Marginalia style is intended for comments added in the margin of text. The style also is useful for creating sideheads—headings against the left margin, which often are used in technical documentation. To set up sideheads, create body-text paragraph styles with two inches or more indentation from the left. Then, place the cursor at the start of a body-text paragraph, add the frame, and apply the Marginalia style.</td>
</tr>
<tr>
<td>OLE</td>
<td>The default style for OLE objects and floating frames. The default places the frame at the top and center of a body of text.</td>
</tr>
<tr>
<td>Watermark</td>
<td>The default style for a watermark, a graphic placed as the background to a body of text. The default is a Through wrap, with text passing over the frame and anything in it. The graphic should be faint enough that text still is readable over top of it.</td>
</tr>
</tbody>
</table>

Creating new frame styles

You can access frame settings by selecting New or Modify in the Styles and Formatting window for a frame style.

- **Type page**: sets the size and position of the frame. One of the most useful options here is AutoSize, which automatically adjusts the frame to the object it contains. If the frame style is one used automatically, then this option should be selected.
- **Options page**: sets whether the contents of the frame are printed and able to be edited in a read-only document. This page also sets the text direction, which is useful if you are using the frame for contents in a language that uses right-to-left text direction.
- **Wrap page**: sets how text is positioned in relation to the frame and how close text comes to a frame. If you want the frame contents to stand out from the paragraphs around it, set the wrap to None. This probably is the single most important page for frames.
- **Background page**: sets the background color or graphic. This page is useful mostly for text frames in complex page layouts, in which a text frame has an appearance different from the general background of the page.
- **Borders page**: sets the line around the frame, if any. Many new designers make the mistake of adding a border to every frame. However, when a colored background distinctly marks the division between the frame’s contents and the rest of the page, borders are unnecessary.
- **Columns page**: this page can be ignored unless the frame is being used for text. The page is the same as is used to set up a page style, and its parameters are described in the section “Columns page” on page 26.
- **Macro page**: sets a macro to use with the frame in order to trigger an action when the user interacts with the frame. These options are useful only in an on-line Writer or HTML document.
Working with page styles

Page styles control page properties (margins, page size, header and footer, among others). However, unlike paragraphs, which can have directly applied properties, pages only have a page style and no directly applied properties.

Christian is a lawyer from California, USA. For his letters, the first page has his letterhead, and subsequent pages only identify the recipient, the date, and the page number. Christian does this using page styles. He also uses page styles to comply with the spacing requirements (such as margins) for legal briefs in California State courts.

This section describes how to create a new page style, explains the meaning of some of the options in the Page style dialog, and illustrates their usage.

Creating a new page style

Unlike other styles, page styles can be created or modified only by using the Styles and Formatting window. Open the Styles and Formatting window and click the Page Styles icon \(\text{\

Right-click anywhere in the window and select New. It does not matter if you right-click a style or right-click in blank space.}

The Page Style dialog contains eight pages.

The Organizer page

The Organizer page is described in “The Organizer page” on page 5.

The next style property

Use the Next style property to specify the style for the subsequent page style element. This property is particularly important for a page style, as the following example demonstrates.

Setting up a title page

Consider a common scenario: you want the document to have a title page that is different from the rest of the document:

- It should not have a header or page number.
- The left and right margins should be the same.

For the title page, we can use the predefined First Page page style that comes with LibreOffice, and for the rest of the document, we can use the Default page style.

Figure 21 shows the required flow of page styles. On the Organizer page of the Default page style, leave the Next Style property set to Default. On the Organizer page of the First Page style, make sure that the Next Style property is set to Default.
Depending on your requirement, it may be possible to achieve this just by using the Default page style. On the document’s first page, deselect the Same content on first page option with Header on selected. The header can thus be omitted from the first page.

### General settings for the page style

The Page page of the Page Style dialog is where you can control the general settings of the page. The page consists of three sections, plus a preview area in the top right corner.

In the Paper format section, you can specify the size of the paper choosing from one of the many predefined formats. Selecting “user”, you can use the Width and Height fields to define your own paper size. If using a predefined format, select the orientation of the paper between portrait and landscape. If your printer has more than one tray, you can specify the tray from which to print pages in the new page style.

In the Margins section, specify the size of the margins in your preferred unit of measurement. If you select Mirrored for Page layout in the Layout settings section, then the names of the margins change from Left and Right to Inner and Outer.
In the *Layout settings* section, choose the desired *Page layout* from the four available options. Decide whether the page style being defined applies to both left and right pages (default), or applies to right or left only. Some considerations:

- If you plan to bind the printed pages using this style like a book, select a mirrored layout. Use the *Format* drop-down menu to determine the page numbering style to apply to this page style.
- A common practice in page layouts is to have asymmetrical page margins—both for left and right margins and for top and bottom margins. There are various schemes for accomplishing this. The most common of them follow these two general rules for printed page layouts: (a) The outer margin (right margin on a right-hand page) would have a wider margin than an inner margin (left margin on a right-hand page); (b) The bottom margin would be larger than a top margin. The rationale for an asymmetrical page layout is allowing more space for readers to place their hands while holding the books or other printed documents. About.com describes some page layouts on their Web site: *Perfect Proportions Using Page Margins in Desktop Publishing*.
- If you want the first page of a new chapter to always start on a right (recto) page, make sure that the page style for the first chapter page is set for the right page only by making this selection in the *Layout settings* field. The typical procedure for the rest of a chapter is to define a single “mirrored” page style for both left and right pages. A mirrored page can have different headers and footers. If done this way, every chapter will use two page styles.
- You can choose to define separate page styles for left and right pages, if you want the pages to be very different in appearance (for example, different margins or headers and footers only on right pages but not on left pages; imagine a book with a full-page photograph on the left pages and text on the right pages). In that case, make sure that the *Next Style* field for the first page style is then set for a left-only page, which, in turn, is then set to be followed by a right-only page style. If done this way, every chapter will use three page styles. A hypothetical case might have these page-style names: *First page*, *Left*, and *Right*.

If you check the *Register-true* box, Writer will create a vertical grid on the page with a spacing between grid points that depends on the selected *Reference Style*. The vertical grid makes sure that text printed on adjacent columns, opposite pages, or even both sides of the same sheet of paper, is aligned—making it easier to read as well as being more pleasant to see.

**Background and Border pages**

Use the *Background* page to apply a background or the *Border* page to draw a border around the text area of the page (the margins). You can also add a shadow to the text area. You can choose between a solid color or a graphic image for the background and several styles of line for the borders. Note that the page area affected by these changes does not include the area outside the margins. If you plan to print on colored paper and want to have a feel of the final result you will obtain or want to use a light color for the font, rather than changing the background, then go to *Tools > Options > LibreOffice* and in the *Appearance* section, change the *Document background* color.

**Header and Footer pages**

You can associate a different header or footer to each page style. This property makes it very easy to have different headers on left and right pages, to avoid headers on pages at the start of a new chapter, and so on. You can also have a different header or footer on the same page style where it is used for the first page of a document.

Setting up the header and footer pages is straightforward. The instructions here refer to the header, but the footer page has the same options. Activate the input boxes by selecting *Header*.
on, then specify the left margin, right margin, and spacing to the main text area. For the height of the header area, you can either select the AutoFit height box, which will make Writer adapt the size to the contents, or specify the height manually. Clicking More opens a new dialog, where you can set the borders and background of the header area.

If you deselect the Same content left/right box, you can specify a different header for left or right pages, even if you use a single style for both as shown here. This option is not available on the predefined Left and Right page styles or on any other page style defined to be a left or right page only.

Deselecting Same content on first page allows you to set a different header on a first page when using the same style for the Next Style.

![Figure 23: Different content on left and right pages](image)

### Columns page

Use this page to create the desired column layout for the page style. The page is subdivided into three sections: Settings, Width and Spacing and Separator Line. The Settings section contains thumbnails of predefined columns settings you can select, as well as a text box where you can enter the desired number of columns if you need to create a customized one.

After you select more than one column, the Width and Spacing section becomes active. If you are not satisfied with the predefined settings (equally spaced columns), deselect the AutoWidth option and enter the parameters manually. When you work with multiple columns per page, you can also fine tune the position and size of a separator line between the columns.

### Footnote page

Use this page to adjust the appearance of the footnotes. Keeping the default setting Not larger than page area, the footnotes area is calculated automatically on the basis of the number of footnotes. If you prefer to control manually the maximum space that footnotes can take, select the Maximum footnote height option and enter the value in the preferred unit of measurement. Use the second section of the page to customize the separator between the footnotes and the main area.

### Example: A book chapter sequence of pages

Book chapters typically start on a right-hand page, with the first page of the chapter having a different layout from the rest of the pages. The other pages in the chapter are “mirrored” for double-sided printing. For example, page numbers in the header or footer may be positioned on the outside edge of pages and in this instance a wider margin (allowing for binding) is placed on the inside edge.

Table 2 shows the properties of two page styles (Right Page and Default) set up for a typical book chapter’s sequence of pages.
Table 2: Properties of customized page styles for book chapter

<table>
<thead>
<tr>
<th>Page Style</th>
<th>Desired effect</th>
<th>Property: setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Page</td>
<td>First page always on the right (an odd-numbered page)</td>
<td>Page &gt; Page layout &gt; Only right</td>
</tr>
<tr>
<td></td>
<td>No header or footer</td>
<td>Header &gt; Header on: Not selected</td>
</tr>
<tr>
<td></td>
<td>Top margin of page larger than on other pages</td>
<td>Page &gt; Margins &gt; Top: 6.00cm</td>
</tr>
<tr>
<td></td>
<td>Mirrored margins</td>
<td>Page &gt; Page layout: Mirrored</td>
</tr>
<tr>
<td></td>
<td>Header with page number on the top outside of the page and chapter title in the top middle center of the page</td>
<td>Header &gt; Header on: Selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Header &gt; Header &gt; Same content left/right: Not selected</td>
</tr>
<tr>
<td>Default</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 24 illustrates the transitions from the Right Page to Default page styles, with the change of header between left and right pages shown by the # symbol.

Step 1. Set up the Right Page style.

1) On the Styles and Formatting window, click the Page Styles icon ( ) to display a list of page styles.
2) Right-click on Right Page and select Modify from the pop-up menu.
3) On the Organizer page of the Page Style: Right Page dialog, change Next Style to Default.

Figure 25: Specifying the next style after the first page of a chapter

4) On the Page tab, specify a larger left margin for binding, and a larger top margin to move the chapter title down the page.
5) On the **Header** and **Footer** pages, be sure the **Header on** and **Footer on** options are not selected. Click **OK** to save your changes.

**Step 2. Set up the Default page style.**

1) On the Styles and Formatting window, in the list of page styles, right-click on Default and select **Modify** from the pop-up menu.

2) On the **Organizer** page of the Page Style: Default dialog, be sure **Next Style** is set to Default.

3) On the **Page** tab of the Page Style: Default dialog, select **Mirrored** for **Page layout** and set the **Inner** and **Outer** margins to the same width as the **Left** and **Right** margins, respectively, on the **Right Page style**.

4) On the **Header** page of the Page Style: Default dialog, select the **Header on** option and deselect the **Same content left/right** option. Click **OK** to save your changes.
Figure 28: Setting up the header properties for the Default page style

Step 3. Set up the Heading 1 paragraph style to start on a new right-hand page.

1) In the Styles and Formatting window, on the Paragraph Styles page, right-click on Heading 1 and select Modify.
2) On the Text Flow page of the Paragraph Style dialog, in the Breaks section, select Insert, With Page Style, and Right Page. Click OK to save your changes.

Figure 29: Setting a paragraph style to start on a page of a selected style

Step 4. Start a new chapter.

Apply the Heading 1 paragraph style to the first paragraph, which is the title of the chapter.

Note
By default, the Heading 1 paragraph style is assigned to Outline Level 1. The assignment of paragraph styles to outline levels is done through Tools > Outline Numbering.

Step 5. Set up the page headers.

1) On a left page, put the cursor in the header and insert a page number field on the left (Insert > Fields > Page Number).
2) Press Tab to put the cursor in the middle and insert a Chapter reference:
   Press Control+F2 (or choose Insert > Fields > Other from the menu bar) to display the Fields dialog (Figure 30).
   On the Document page, for Type, select Chapter and for Format, select Chapter name. Make sure that Level is set to 1 and then click Insert.
3) On a right page, put the cursor in the header, press the Tab key, insert a Chapter reference, press Tab again, and insert a page number field.
4) If you need to adjust the tab stops for the header, modify the Header paragraph style. Do not manually adjust the tab stops.
Working with list styles

List styles (also called numbering styles) work together with paragraph styles. They define indentation, alignment, and the numbering or bullet characters used for list items. You can define many list styles, from simple bulleted lists to complex multi-level (nested) lists.

As with other styles, the main reasons for using list styles are consistency and speeding up your work. Although you can create simple lists quickly by clicking the Numbering On/Off or Bullets On/Off icons on the Formatting toolbar, and create quite complex nested lists using the buttons on the Bullets and Numbering toolbar, the appearance of the resulting lists may not be what you want—and you might want to have more than one style of list. You can use the Bullets and Numbering choice on the Format menu to manually format the appearance of some or all of the lists, but if you later need to change their appearance, you will have a lot of manual work to do.

Note

LibreOffice uses the terms “numbering style” and “list style” inconsistently, but they are the same thing. For example, the tooltip in the Styles and Formatting window says “List Styles”, but its style dialog says “Numbering Style”.

Defining the appearance of a nested list

A nested list is a numbered or bulleted list with subordinate (usually indented) numbered or bulleted lists. Rather than just a list of numbered items (1, 2, 3...), a nested list may have item 1, then indented items numbered a, b, c or i, ii, iii or some other numbering method before the main number 2. With numbering styles, you can achieve any combination of numbering formats you want. A nested list may even combine numbered items with bulleted items.

There is no difference between defining a nested list style or a simple list, although nested lists require more work. An example of a nested list is given in Chapter 3, Working with Text. In that case, the list was built using one of the predefined outline schemes as a starting point, while in this section we follow a more general approach so that the list can more fully suit your needs.
Creating a new list style

The dialog to create a new list style consists of six pages in addition to the usual Organizer page discussed in “The Organizer page” on page 5.

Bullets, Numbering Styles, and Image pages

The Bullets, Numbering Style, and Image pages contain predefined formatting for list item symbols (bullets or numbers). To use one of them for your style, click on the image. A thick border indicates the selection. The bullets on the Bullets tab are font characters; those on the Image tab are graphics.

If you choose a graphics bullet, on the Options page you can select the Link Graphics option to create a link to the graphic object rather than embedding it in the document. If you decide to link the graphic, keep in mind that the bullet will not be displayed when the document is opened on a different computer (unless the same graphic file is located in the same location on both computers) or if the graphic file used is moved to a different location on the computer.

Outline page

Use the Outline page to select from eight predefined nested lists. You can also select one and use it as a starting point for your own style, customizing the list using the Position page and the Options page, as described below.

Position page

Use the Position page to fine tune the indentation and spacing of the list item symbol and the text of the list item. This page is particularly effective when used in combination with the Options page.

![Image of list style settings]

**Figure 31: Position settings for a List style**
You can adjust the following settings for each individual level or all levels at once (to make them all the same). It is generally easier to adjust the settings in the order given below, instead of the order on the dialog. That is, start from the overall indentation for the list elements, then fix the position of the symbols, and finally adjust the alignment of the symbols.

- **Numbering followed by**: the character to follow the numbering symbol (plus any characters—for example a punctuation mark—chosen on the Options page to appear after the number). Choose between a tab stop, a space, or nothing. If you select the tab stop, you can specify the position of the tab.
- **Indent at**: how much space is reserved for the numbering symbol, measured from the left page margin. The alignment of the first line of the list is also affected by any tab you may have set to follow the numbering.
- **Aligned at**: the position of the numbering symbol, measured from the left margin of the page.
- **Numbering alignment**: how the numbering (including any text before or after as set in the Options page) will be aligned. The **Aligned at** value determines the symbol alignment.

---

**Note**
When defining an indentation different from 0, the position of the tabulation is not considered.

**Tip**
In normal circumstances, setting the **Numbering followed by** distance to be equal to the **Indent at** distance works well. See Figure 32 for a graphic representation of the effects of the above parameters.

![Figure 32: A numbered list of CD tracks highlighting the various elements](image)

**Position page for older documents opened in LibreOffice**
If your document was created with an earlier version of a similar program such as OpenOffice.org, or if the document was saved for compatibility reasons using the ODF file format version 1.1 or earlier, the **Position** page will appear as in Figure 33.
In this case you can adjust the following settings:

- **Indent**: the indentation of the number or bullet area, measured from the left margin of the paragraph linked to the numbering style. In other words, if the paragraph style already has an indentation, when the list style is applied the indentations are added together. For any level other than Level 1, the **Relative** option causes the indentation to be measured from the start of the previous level rather than from the page margin.

- **Width of numbering**: how much space is used by the numbering symbol. Writer reserves this space, even if only part of it is used.

- **Minimum spacing numbering <-> text**: the spacing between the right edge of the numbering symbol and the text. If the spacing to text is not sufficient, Writer will honor this setting by expanding the numbering area. Setting the minimum spacing between numbering and text is very useful when right-aligning the numbering or when there is much text before or after the numbering.

- **Numbering alignment**: how the numbering (including any text before or after) will be aligned.

**Tip**

To fully appreciate how the Numbering alignment works, try to create a numbered list with more than ten elements and make sure that enough room has been made for numbers with two or more digits. You may also wish to right-align numbers 10 or greater, as in Figure 32 on page 32.

**Options page**

Use the **Options** page (Figure 34) to define the style of the outline levels. The options available on this page depend on the type of marker selected for the list. First, on the left side, select the level you want to modify. To modify all ten levels at once, select **1 – 10** as the level. If you started from a predefined outline, some of the levels will already have settings.

Depending on the numbering style selected in the **Number** box (bullet, graphic, numbering), some of the following options become available on the page:

- **Before**: any text to appear before the number (for example, Step).
- **After**: any text to appear after the number (for example, a punctuation mark).
- **Start at**: the first value of the list (for example, you might want the list to start at 4 instead of 1).
- **Character Style**: the style to be used for the number or bullet.
- **Character button**: click to select the character for the bullet.
The Options page for a list style

- **Graphics selection button**: opens a list of available graphics (Gallery) or allows the selection of a file on the hard disk to be used as the list marker.
- **Width and Height**: the dimensions of the graphic marker.
- **Alignment**: the alignment of the graphic object.
- **Keep ratio** option: fixes the ratio between the width and the height of the graphic marker.

The right-hand side of the dialog shows a preview of the modifications made.

To revert to the default values, click the **Reset** button in the bottom right corner. Finally, if you wish to use consecutive numbers regardless of the outline level, check the **Consecutive numbering** box at the bottom of the page.

### Combining list and paragraph styles

When applying a list style, the underlying paragraph style remains unchanged. If your list must also have a certain font size, indentations, and so on, you might expect to first apply a paragraph style and then a list style (or the other way around). However, you can embed a list style in a paragraph style using the Numbering page of the Paragraph Style dialog, and then apply only the paragraph style to the list.

This section gives an example of combining list and paragraph styles.

1. Create a list style you want to use for the paragraph. For example: **MyNumberedList**.
2. Create a new paragraph style.
3. On the **Organizer** page of the Paragraph Style dialog:
   a) Give the new paragraph style a name, say **NumberedParagraph**.
   b) For the **Next Style**, choose **NumberedParagraph** (this will make the following paragraph also be in this style, until you choose a different style).
c) In *Linked with*, choose **None**.
d) Leave **Custom Styles**, in the *Category* field.

4) Set up this paragraph style to your liking. Because the indentation is controlled by the *List* style, to avoid undesired interactions do not change the indent settings on the *Indents & Spacing* page. (You might want to change the spacing above and below the paragraph.)

5) On the **Outline & Numbering** page, choose the *MyNumberedList* style created in step 1.

6) Click **OK** to save this style.

To have full control, it is common practice to define three base paragraph styles for lists: *List Start* for the first element of the list, *List Continue* for the subsequent elements of the list, and *List End* for the last element of the list. You should also define a paragraph style to be used for unnumbered list items (one for each nested level you intend to use) as well as an introductory style for the paragraph preceding the start of the list (to allow for keeping the introductory paragraph with the first list item, or for specifying spacing before the first list item that is different from the spacing between other paragraphs).

**Example: Creating a simple list style**

In this example, we will create a numbered list that is used to number the songs on a CD. The numbers are right aligned, and some space is left between the number and the title of the track.

As we want to reuse the same numbered list for other CDs, we will define a new list style and then apply it to the tracks list.

**Creating the CDTracks numbered list**

As for the previous example, start by clicking the **List Styles** icon (fifth from the left) in the *Styles and Formatting* window. Then right-click anywhere in the list box and choose **New**.

The Numbering style dialog is displayed. For the *CDTracks* style, we need to customize fields in the *Organizer*, the *Options*, and the *Position* pages.

<table>
<thead>
<tr>
<th><strong>Style fields</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter <strong>CDTrack</strong></td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>Custom styles will be OK for us.</td>
</tr>
</tbody>
</table>

Modify the options of the *Options* page as follows:

1) In the *Level* box, choose **1**.
2) In the *Numbering* list, choose **1, 2, 3,...**.
3) Leave the *Before* and *After* boxes empty.
4) Leave the *Character Style* field as **None**.
5) *Show sublevels* should be grayed out.
6) Make sure *Start at* is set to **1**.
7) Do not select **Consecutive numbering**.

As discussed above, the numbered list will adopt the settings of the underlying paragraph style. If you want to use a special font, size or color for the numbering, you can create a character style and apply it in the *Options* page.

If you want the word *Track* to appear before the number, add it to the *Before* field in the *Options* dialog. Do not forget to add a space character to separate the word from the number.
Set up the final parameters of the CDTracks list style in the Position page.

1) In the Level box, choose 1.
2) For Numbering followed by, choose tab stop and set it at 4.0cm.
3) For Numbering alignment, choose Right.
4) For Aligned at choose 1.5cm. (this refers to the alignment of the numbers)
5) For Indent at choose 4.0cm. (This sets the indentation of the whole list.) Click OK to finish.

**Applying the list style**

Now that the list style is available, it can be quickly applied to any list in the document:

1) If starting a new list, before pressing Enter to start a new line, double-click on the desired list style name in the Styles and Formatting window.
2) If you already have a list, select it and then double-click on the desired list style name in the Styles and Formatting window.

---

**Note**

Remember that applying a list style does not affect the characteristics of the underlying paragraph; therefore you may want to check if you are satisfied with the paragraph style before applying the list style.

If you have more than one list in a document, the second and subsequent lists with the same style continue their numbering from the previous list. To restart at 1, place the cursor anywhere in the paragraph you want numbered 1, right-click, and choose **Restart numbering**.

To stop using numbering, press the **Numbering On/Off** button on the Standard Toolbar. The final result is illustrated in Figure 32.